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Scientific Simulation Issues…Scientific Simulation Issues…
• Fundamental Parallel Programming

→ Synchronization,  Coordination & ControlControl

• Distributed Data Organization
→ Locality,  Latency Hiding,  Data MovementData Movement

• Long-Running Simulation Experiments
→ MonitoringMonitoring,  Fault RecoveryFault Recovery

• Massive Amounts of  Data/Information
→ Archival Storage,  VisualizationVisualization

• Too Much Computer, Not Enough Science!
→ Need Some Help…Need Some Help…
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Potential Benefits fromPotential Benefits from
Computer Science Infrastructure:Computer Science Infrastructure:

•• OnOn--TheThe--Fly VisualizationFly Visualization
⇒ Intuitive Representation of Complex Data
⇒ Interactive Access to Intermediate Results

•• Computational SteeringComputational Steering
⇒ Apply Visual Feedback to Alter Course/Restart
⇒ “Close Loop” on Experimentation Cycle

•• Fault ToleranceFault Tolerance
⇒ Automatic Fault Recovery, Load Balancing
⇒ “Keep Long-Running Simulations Running Long” ☺

Viz

Steer
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•• Collaborative Infrastructure for Interacting with Collaborative Infrastructure for Interacting with 
Scientific Simulations:Scientific Simulations:
⇒ Run-Time Visualization by Multiple Viewers

→ Dynamic Attachment as Needed, Independent Views
⇒ Coordinated Computational Steering

→ Model & Algorithm  Parameters
⇒ Heterogeneous Checkpointing/Fault Tolerance

→ Monitoring & Data Recovery from Faults, Task Migration
⇒ Coupled Parallel Models, Data Redistribution

(Not a Climate Modeling or Simulation Tool…!  ☺)
“Collaborative,  User Migration,  User Library  for  Visualization  and  Steering”

(Not a Climate Modeling or Simulation Tool…!  ☺)
“Collaborative,  User Migration,  User Library  for  Visualization  and  Steering”
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Collaborative Combustion SimulationCollaborative Combustion Simulation
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task

CUMULVS ArchitectureCUMULVS Architecture
coordinate the consistent collection and dissemination of

information to/from parallel tasks to multiple viewers

interact with live distributed/parallel software simulation
supports most target platforms (PVM, MPI, …)

viewer
viewer

viewer
task

tasktasktasktask

task

tasktasktask

Host A

Host B
Host C

remote scientist
using immersive
or 3D environment

remote scientist
using commercial
viz tool

local  scientist
using custom
GUI

CUMULVS

exists in 3 pieces:
application library,

viewer library,
and separate fault 
recovery daemon
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CUMULVS Visualization FeaturesCUMULVS Visualization Features
• Interactive Visualization

⇒ Simple API for Scientific Visualization
⇒ Apply To Your Favorite Visualization Tool

• Minimize Overhead When No Viewers
⇒ One Message Probe, No Application Penalty

• Send Only Viewed Data
⇒ Partial Sub-Array/Resolution Control

• Rect Mesh & Particle Data
• Common (HPF) Data Distributions

⇒ BLOCK, CYCLIC,  EXPLICIT, COLLAPSE
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Multiple Simultaneous ViewsMultiple Simultaneous Views

Density Temperature
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Multiple Distinct ViewsMultiple Distinct Views

Varying
Levels of 
Detail…
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Examples of CUMULVS CallsExamples of CUMULVS Calls
Application Side LibraryApplication Side Library

#include "stv.h“

stvInit( &argc, &argv,

“csimple”, STVTAG, NTASKS, myInstance );

decompId = stv_decompDefine( 3,

axisType[], axisInfo1, axisInfo2,

glb[], gub[], prank, pshape[] );

fieldId = stv_fieldDefine( density, "density",
decompId, fieldOffsets[], declared[], stvFloat,
procAddr[], stvVisOnly );

. . . stv_sendReadyData( stvSendDefault );

#include "stv.h“

stvInit( &argc, &argv,

“csimple”, STVTAG, NTASKS, myInstance );

decompId = stv_decompDefine( 3,

axisType[], axisInfo1, axisInfo2,

glb[], gub[], prank, pshape[] );

fieldId = stv_fieldDefine( density, "density",
decompId, fieldOffsets[], declared[], stvFloat,
procAddr[], stvVisOnly );

. . . stv_sendReadyData( stvSendDefault );
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Examples of CUMULVS CallsExamples of CUMULVS Calls
Viewer Side LibraryViewer Side Library

#include “stv.h”
#include “stv_glob.h”

STV_VIEWER VIEWER, STV_VIEW_FIELD VF, STV_VIEW_FIELD_GROUP VFG;

stv_viewer_init( &VIEWER, appname, blocking );

VF = stv_get_view_field_name( fieldName,
VIEWER->vfields, VIEWER->nvfields );

VF->selected = stvTrue;
VF->view_type = stvFloat;
VF->view_storage_order = stvRowMajor;
. . .

VFG = stv_viewer_submit_field_request( VIEWER, visRegions[], freq,
stvFieldRqstDefault, &restart );

do {
stv_viewer_receive_frame( &VFG, VIEWER, &restart, stvMsgNoBlock );

ptr = VFG->field_values[ fieldIndex ][ regionIndex ];
fval = STV_VALUE_OF( ptr, float );

} while ( . . . );

stv_viewer_release_field( &VFG, VIEWER );

#include “stv.h”
#include “stv_glob.h”

STV_VIEWER VIEWER, STV_VIEW_FIELD VF, STV_VIEW_FIELD_GROUP VFG;

stv_viewer_init( &VIEWER, appname, blocking );

VF = stv_get_view_field_name( fieldName,
VIEWER->vfields, VIEWER->nvfields );

VF->selected = stvTrue;
VF->view_type = stvFloat;
VF->view_storage_order = stvRowMajor;
. . .

VFG = stv_viewer_submit_field_request( VIEWER, visRegions[], freq,
stvFieldRqstDefault, &restart );

do {
stv_viewer_receive_frame( &VFG, VIEWER, &restart, stvMsgNoBlock );

ptr = VFG->field_values[ fieldIndex ][ regionIndex ];
fval = STV_VALUE_OF( ptr, float );

} while ( . . . );

stv_viewer_release_field( &VFG, VIEWER );
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CUMULVS Particle HandlingCUMULVS Particle Handling
• Particle Data Fundamentally Different

⇒ Data Fields Encapsulated in a Particle Container
⇒ Explicit Coordinates Per Particle

• Particle-Based Decomposition API
⇒ User-Defined, Vectored Accessor Routines

• Viewing Particle Data
⇒ AVS Module Extensions
⇒ Tcl/Tk Slicer Particle Mode

x,y,z
int foo;

double bozo[10];
float bar;

x,y,z
int foo;

double bozo[10];
float bar;

x,y,z
int foo;

double bozo[10];
float bar;

x,y,z
int foo;

double bozo[10];
float bar;
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Example Particle APIExample Particle API
chargeId = stv_particleDefine( "charge",

2, glb[], gub[], NTASKS,
get_charge(), (STV_VALUE) NULL,
(STV_MAKE_PARTICLE) NULL, (STV_VALUE) NULL );

stv_pfieldDefine( "velMagn", chargeId, stvFloat, nElems,
get_charge_pfield(), (STV_VALUE) PF_VEL_MAGN,
(STV_SET_PFIELD) NULL, (STV_VALUE) NULL,
stvVisOnly );

void get_charge( int chargeIndex, STV_REGION Region,
STV_VALUE clientData, STV_PARTICLE_ID *id,
int *coords );

void get_charge_pfield( STV_PARTICLE_ID id,
STV_VALUE fieldId, STV_VALUE *value, int *nelems );

chargeId = stv_particleDefine( "charge",
2, glb[], gub[], NTASKS,
get_charge(), (STV_VALUE) NULL,
(STV_MAKE_PARTICLE) NULL, (STV_VALUE) NULL );

stv_pfieldDefine( "velMagn", chargeId, stvFloat, nElems,
get_charge_pfield(), (STV_VALUE) PF_VEL_MAGN,
(STV_SET_PFIELD) NULL, (STV_VALUE) NULL,
stvVisOnly );

void get_charge( int chargeIndex, STV_REGION Region,
STV_VALUE clientData, STV_PARTICLE_ID *id,
int *coords );

void get_charge_pfield( STV_PARTICLE_ID id,
STV_VALUE fieldId, STV_VALUE *value, int *nelems );



ORNL Kohl/2005-14

CUMULVSCUMULVS
Steering FeaturesSteering Features

• Computational Steering
⇒ API for Interactive Application Control

• Modify Parameters While (Long) Running
⇒ Eliminate Wasteful Cycles of  Ill-Posed Simulation
⇒ Drive Simulation to More Interesting Solutions
⇒ Enhance Convergence of  Numerical Algorithms

• Allows “What If” Explorations
⇒ Closes Loop of  Standard

Simulation Cycle
⇒ Explore Non-Physical Effects…

visualization

?

!

steering
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Coordinated SteeringCoordinated Steering
• Multiple, Remote Collaborators (“Steerers”)
• Simultaneously Steer Different Parameters

⇒ Physical Parameters of Simulation
⇒ Algorithmic Parameters ~ e.g. Convergence Rate

• Cooperation Among Collaborators…
⇒ Parameter Locking Prevent Conflicts
⇒ Vectored/Indexed Parameters…

• Parallel/Distributed Simulations
⇒ Synchronize with Parallel Tasks
⇒ All Tasks Update Each Parameter in Unison
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Example Steering ParameterExample Steering Parameter
DefinitionsDefinitions

paramId = stv_paramDefine( “probability”,

(STV_VALUE) &prob, stvDouble, stvVisOnly );

paramId = stv_vparamDefine( “eField”,

STV_VALUE field_params[], char *field_names[],
field_types[], 3, stvVisOnly );

...nSteered = stv_sendReadyData( stvSendDefault );

if( stv_isParamChanged( paramId ) )

...

paramId = stv_paramDefine( “probability”,

(STV_VALUE) &prob, stvDouble, stvVisOnly );

paramId = stv_vparamDefine( “eField”,

STV_VALUE field_params[], char *field_names[],
field_types[], 3, stvVisOnly );

...nSteered = stv_sendReadyData( stvSendDefault );

if( stv_isParamChanged( paramId ) )

...
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• Natural Extension to CUMULVS Viewer Scenario
⇒ Promote “Many-to-1” → “Many-to-Many”

• Translate Disparate Data Decompositions
⇒ Parallel Data Redistribution Among Common Data Fields

→ stv_couple_fields( fieldID, appname, fieldname, ... );

⇒ Fundamental Model Coupling Capability (Data Exchange)
→ Next Steps ~ Interpolation in Space & Time, Flux Conserve, Units…

Parallel Model Coupling in CUMULVSParallel Model Coupling in CUMULVS

E.g. Regional Climate Modeling:

Ocean
Atmosphere

“Temperature”

CUMULVS

V
V V

VV

Appl Tasks
as “Viewers”
onto Coupled
Appl Tasks…

Appl Tasks
as “Viewers”
onto Coupled
Appl Tasks…
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Simple CUMULVS Coupling ExampleSimple CUMULVS Coupling Example

Sinusoidal Forcing Function Live Surface Boundary
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Simple Coupling CodeSimple Coupling Code

coupleId = stv_couple_fields( fieldId,

"wavesAppl", "density",

DST_CFREQ, SRC_CFREQ,
dstNoSynch, srcNoSynch, blocking );

...stv_sendReadyData( stvSendDefault );

stv_couple_finished( coupleId );

coupleId = stv_couple_fields( fieldId,

"wavesAppl", "density",

DST_CFREQ, SRC_CFREQ,
dstNoSynch, srcNoSynch, blocking );

...stv_sendReadyData( stvSendDefault );

stv_couple_finished( coupleId );
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Instrumenting Programs for CUMULVSInstrumenting Programs for CUMULVS
• CUMULVS Initialization ~ One Call (Per Task)

⇒ Logical Application Name, Total # of Tasks
• Data Fields (for Visualization & Checkpointing)

⇒ Local Allocation:  Name, Type, Size, Offsets
⇒ Data Distribution:  Dim, Decomp, Processor Topology

• Steering Parameters
⇒ Logical Name, Data Type and Pointer

• Periodic CUMULVS Handler
⇒ Pass Control for Transparent Access/Processing

• Typically 10s of Lines of Code at Most…  ☺
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Decompositions and Data FieldsDecompositions and Data Fields

• Decomposition = Data Distribution “Template”
⇒ Same Decomp can be Re-used for Many “Fields”
⇒ Describes How “Global” Array is Broken Up

→ Overall Global Coordinates, Block vs. Cyclic Patches, 
Mapping of Patches to Processors…

• Data Fields Associate Actual Data with Decomp
⇒ “Name”, Data Pointer and Type, Local Allocation, 

Position in Processor Decomposition…
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Local Allocation OrganizationLocal Allocation Organization
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CUMULVS Fault Tolerance FeaturesCUMULVS Fault Tolerance Features
• Application Fault Tolerance

⇒ Automatic Detection and Recovery from Failures

• User Directed Checkpointing
⇒ User Decides What/Where to Checkpoint
⇒ Minimizes Stored Data, Adds Semantics

• Heterogeneous Task Migration
⇒ Restart Tasks on Heterogeneous Hosts
⇒ Restart can be Automatically Repartitioned if  New Hosts  

of  Different Size/Topology (Burnt Offering Required ☺)

• Avoids Synchronizing Distributed Tasks
⇒ Asynchronous Checkpoint Collection and Fault Detection
⇒ Minimize Intrusion of  Checkpoint/Restart
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RunRun--Time Fault MonitorTime Fault Monitor
• One Checkpointing Daemon 

(CPD) Per Host
⇒ Ckpt Collector/Provider
⇒ Run-Time Monitor
⇒ Console for Restart/Migrate

• CPDs Comprise Fault-
Tolerant Application…
⇒ Handle Failure of Host/CPD
⇒ Coordinate Redundancy
⇒ Ring Topology
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Rollback Versus Restart… Rollback Versus Restart… 
• Rollback Recovery:

⇒ Only Replace Failed Tasks, “Roll Back” the Rest
⇒ Elegant & “Cool”, But You Must…

→ Monitor ALL Communication for Restart Notification
→ Unroll Program Stack, Reset Comm & File Pointers…

⇒ Necessary for High Overhead Restart Cases
• Restart Recovery:

⇒ “Genocide” ~ Kill Everything & Restart All Tasks
⇒ Simple Approach, No Additional Instrumentation
⇒ Not as Efficient a Recovery in All Cases…
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Checkpoint Data CollectionCheckpoint Data Collection
• Data from Each Local Task Collected/Committed

→ stv_checkpoint();

• Invoke When Parallel Data / State “Consistent”…
⇒ Highly Non-Trivial in General! (Chandy/Lamport)
⇒ Straightforward for Most Iterative Applications

→ Save Checkpoint at Beginning or End of  Main Loop

• No Automatic Capturing of  Other Internal State:
⇒ Open Files, I/O, Messages-in-Transit…
⇒ CUMULVS Assumes User Handles This Recovery

→ Can Be Done Manually Using Saved Checkpoint State
→ Future Extensions to Assist…
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Manual Software InstrumentationManual Software Instrumentation
• SPDT 98 Case Study ~ SW Instrumentation Cost

Instrumentation: Seismic: Wing Flow:
Original Lines of Code 20,632 2,250

Vis / Steer Variable Decls
CP Restart Initialization
CP Rollback Handling
Total Instrumentation

3 3
73

21 12
48

41 34

Vis / Steer System Init

204 ~ 1.0 % 188 ~ 7.7 %
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Checkpointing EfficiencyCheckpointing Efficiency
• SPDT 98 Case Study ~ Execution Overhead

Seismic Overhead:  4-14% Restart, +1-3% Rollback
Wing Overhead:  8-15% Restart, +0-2.5% Rollback

(Checkpointing Every 20 Iterations ~ every 15 sec to 4 mins…!)

Experiment: SGI: Cluster: Hetero:
Seismic - No Checkpointing
Seismic - Checkpoint for Restart
Seismic - Checkpoint for Rollback

2.83 6.23 9.46
2.99 6.50 10.76
3.03 6.66 10.90

Wing - No Checkpointing
Wing - Checkpoint for Restart
Wing - Checkpoint for Rollback

0.69
0.77
0.79

1.58
1.71
1.71

6.14
7.10
7.30

Seconds per Iteration
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CUMULVS RunCUMULVS Run--Time SystemTime System

• Originally built on PVM (Parallel Virtual Machine)
• MPI Standard has evolved, become proliferate…

⇒ Many other available communication subsystems:
→ OpenMP, ECho (event-based), Linda (tuple-based), etc…

• CUMULVS “works” with these systems…
⇒ If you carry PVM around, too…!  ☺

• “Native” solutions would be “nice”…
⇒ Hmmmm…
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Supporting MPI Applications in CUMULVSSupporting MPI Applications in CUMULVS

• CUMULVS Worked “Fine” with MPI Applications… ☺
• But MPI Didn’t Have Everything We Needed (Internally)

⇒ Static Model, Minimal Operating Environment
⇒ No Name Service/Database; No Fault Recovery/Notification
⇒ MPI_Spawn( )…?  Need Proxy Server for Viewer Attachment?

• Previous Solution:
⇒ Applications Communicate Using MPI or PVM or ???
⇒ CUMULVS Viewers and CPDs Still Attach Using PVM…

• New Communication Substrate Under Development!
⇒ Provide Viz/Steering Features to MPI via Generic TCP/IP!
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New MultiNew Multi--CommunicationCommunication
RunRun--time Environment!time Environment!

• Supports PVM, MPI and TCP Connections
• Simultaneous Use of ANY Subsystem!

⇒ Interactive Selection Based on Availability
→ or Connectivity, such as with MPP systems…

⇒ Application Publishes “Address” for ALL Systems
⇒ Viewer Programs Query Substrates as Desired

→ Each Viewer can Connect Independently…

• Minimal CUMULVS API Changes…
⇒ Mostly Viewers;  Lots of Internal Changes… :-o
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Generic Application Discovery APIGeneric Application Discovery API
• Use Lowest Common Denominator ~ “Files”…  ☺
• Rendezvous via SSH:

⇒ Select “Globally Visible” Spot ~ User@Host:/Directory...
⇒ Directory must be Writable by that User…

• Specify Via Environment Variables:
⇒ STV_MP_RSH, STV_MP_APPHOST, STV_MP_APPUSER

and STV_MP_APPDIR…
• Or, Specify Via Programmatic Interface:

stv_set_appl_discovery( char *apprsh,

char *apphost, char *appuser,

char *appdir );
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MultiMulti--Messaging Viewer Prototype!Messaging Viewer Prototype!

Connected via TCP Connected via PVM

Same Parallel Appl
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•• CCA CCA ““MxNMxN”” Parallel Data RedistributionParallel Data Redistribution
⇒ Builds on CUMULVS Viz & Coupling Protocols
⇒ Also Based on PAWS (LANL)

→ “MxN” Generalizes Capabilities of Both Systems
* Point-to-Point versus Persistent Connections (a la Viz)

→ CUMULVS Viz/Steering Complements PAWS 
Parallel Coupling Work

CCA
Common Component Architecture

CUMULVS Technology IntegrationCUMULVS Technology Integration

Now Called
“Parallel
Coupling
Infrastructure”
(PCI)…

Now Called
“Parallel
Coupling
Infrastructure”
(PCI)…
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CUMULVS as a Foundry to Forge New TechnologyCUMULVS as a Foundry to Forge New Technology

Proposed “Fully Connected”
User-Centric Simulation Cycle

High-Performance Visualization
�� Full Parallel Integration Full Parallel Integration of Pipeline
� CCA “MxN” → “M x N x P x Q x R”!

Scalable Visualization Cache Architecture

Terabyte+
100s GBs 10s GBs

GBs 100s MBs

R3 R2 R1 R0

Parallel
Render

Data
Reorg

For Viz

Reduction & Filtering

“Data”
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Future CUMULVSFuture CUMULVS
Feature Extensions…Feature Extensions…

• Componentization of Functions:
⇒ CCA Components for Viz, Steering and Fault Tolerance

→ For User Components and Framework Services…

• Clean Up Mapping to Other Messaging Substrates
⇒ Functional, but not “Bullet-Proof”…

• Checkpointing Efficiency:
⇒ Tasks Write Data in Parallel / Parallel File System?
⇒ Redundancy Levels, Improve Scalability…
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CUMULVS SummaryCUMULVS Summary
• Interact with Scientific Simulations

⇒ Dynamically Attach Multiple Visualization Front-Ends
⇒ Steer Model & Algorithm Parameters On-The-Fly
⇒ Automatic Heterogeneous Fault Recovery & Migration
⇒ Couple Disparate Simulation Models

• Application Opportunities
⇒ Forging Scalable Visualization Technologies
⇒ “MxN”/PCI, Viz, Steering, F.T. ~ Components in CCA

http://www.csm.ornl.gov/cs/cumulvs.html
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Seismic Example ~ 2D (Tcl/Tk)

Seismic Example ~ 3D (AVS)

Air Flow Over Wing Example ~ 3D (AVS)
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CUMULVSCUMULVS
User Guide NotesUser Guide Notes

ACTS Collection Workshop
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Downloading Latest CUMULVS Downloading Latest CUMULVS 
Software DistributionSoftware Distribution

• Go To CUMULVS Web Site:
http://www.csm.ornl.gov/cs/cumulvs.html

or
http://www.netlib.org/cumulvs (orig version)

� *.tar.gz, *.tar.Z, *.tar.z.uu, *.zip
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SlicerSlicer
Interface Interface 

1. Enter
Application
Name:
e.g. fsimple

1. Enter
Application
Name:
e.g. fsimple

2. Select
Data Field
Name:
e.g. density

2. Select
Data Field
Name:
e.g. density

3. Select
“Lazy” or “Auto”
Color Map Mode.

3. Select
“Lazy” or “Auto”
Color Map Mode.

5. Toggle
“Sleep”
Button
to Start…

5. Toggle
“Sleep”
Button
to Start…

4. Set X,Y
Region
Boundaries,
Z Value…

4. Set X,Y
Region
Boundaries,
Z Value…
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“Gif“Gif--OO--Matic” Web Browser ViewerMatic” Web Browser Viewer

Simple
CGI/HTML

Form
Interface

Simple
CGI/HTML

Form
Interface

Manual
“Refresh”
Manual

“Refresh”
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CUMULVS Viewer for AVS5CUMULVS Viewer for AVS5

Only *1* Custom
AVS Module…

Only *1* Custom
AVS Module…
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CUMULVS Build EnvironmentCUMULVS Build Environment
• Use Sample “Makefile.aimk” (examples/src/):

STV_ROOT = (where you installed CUMULVS)

STV_VIS = NONE

(STV_MP ~ No Longer Needed! ☺☺☺☺)

include $(STV_ROOT)/src/LINUX/Makeincl.stv

���� $(STV_CFLAGS), $(STV_LDFLAGS), $(STV_LIBS)…

���� Use “stvmk” script to build (invokes “make”)

• Include CUMULVS Header Files (include/):
⇒ Defines Constants, Functions, Types

C: #include <stv.h>

Fortran: include ‘fstv.h’
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CUMULVS InitializationCUMULVS Initialization
(“Original”, Backwards Compatible Version)(“Original”, Backwards Compatible Version)

• C:  stv_init( char *appname, int msgtag,

int ntasks, int nodeid );

• Fortran:  stvfinit( appname, msgtag, ntasks, nodeid )

where:
→ appname ~ logical name of application
→ msgtag ~ message tag to “reserve” for CUMULVS*
→ ntasks ~ number of tasks in application
→ nodeid ~ task index of  the caller

E.g.: stv_init( “solver”, 123, 32, 3 );

* For Backwards Compatibility with PVM 3.3 (Before Message Contexts…).
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CUMULVS MPCUMULVS MP--Friendly Initialization Friendly Initialization 
(New Syntax, Includes Argc/Argv, e.g. for (New Syntax, Includes Argc/Argv, e.g. for MPI_InitMPI_Init()…()…☺☺))

• C:  stvInit( int *argc, char ***argv,
char *appname, int msgtag,

int ntasks, int nodeid );

where:
→ argc/argv ~ pointers to process command line arguments
→ appname ~ logical name of application
→ msgtag ~ message tag to “reserve” for CUMULVS*
→ ntasks ~ number of tasks in application
→ nodeid ~ task index of  the caller

E.g.: stvInit( &argc, &argv, “solver”, 123, 32, 3 );

* For Backwards Compatibility with PVM 3.3 (Before Message Contexts…).
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Distributed Data DecompositionDistributed Data Decomposition
• C: int decompIddecompId = stv_decompDefine( int dataDimdataDim,

int *axisTypeaxisType, int *axisInfo1axisInfo1, int *axisInfo2axisInfo2,

int *glb, int *gub, int prank, int *pshape );

• Fortran:  stvfdecompdefine( dataDimdataDim, axisTypeaxisType, axisInfo1axisInfo1,

axisInfo2axisInfo2, glb, gub, prank, pshape, decompIddecompId )

where:
→ decompIddecompId ~ integer decomp handle returned by CUMULVS
→ dataDimdataDim ~ dimensionality of data decomposition
→ axisTypeaxisType ~ decomp type identifier, for each axis

** stvBlockstvBlock, stvCyclicstvCyclic, stvExplicitstvExplicit, stvCollapsestvCollapse

→ axisInfo1,2axisInfo1,2 ~ specific decomposition details, per axis
* E.g. axisInfo1 == Block Size or Cycle Size
* E.g. axisInfo1 == Explicit Lower Bound, axisInfo2 == Upper Bound
* Note:  axisInfo1,2 can be set to stvDefaultInfostvDefaultInfo
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Data Decomposition (cont.)Data Decomposition (cont.)
Global Bounds and PshapeGlobal Bounds and Pshape

• C: stv_decompDefine( …,

int *glbglb, int *gubgub, int prankprank, int *pshapepshape );

• Fortran: stvfdecompdefine( …, glbglb, gubgub,

prankprank, pshapepshape )

where:
→ glbglb ~ lower bounds of  decomp in global coordinates
→ gubgub ~ upper bounds of  decomp in global coordinates
→ prankprank ~ dimensionality of  processor topology (pshape)
→ pshapepshape ~ logical processor organization/topology

* number of  processors per axis
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int decompId, axisType[3], glb[3], gub[3], pshape[2];

axisType[0] = axisType[1] = stvBlock;

axisType[2] = stvCollapse;

glb[0] = glb[1] = glb[2] = 1;

gub[0] = gub[1] = gub[2] = 100;

pshape[0] = 4; /* “Standard” Block Size = 25 */

pshape[1] = 5; /* “Standard” Block Size = 20 */

decompId = stv_decompDefine( 3,

axisType, stvDefaultInfo, stvDefaultInfo,

glb, gub, 2, pshape );

Example Decomposition #1Example Decomposition #1
3D Standard Block Decomp on 2D Processor Array3D Standard Block Decomp on 2D Processor Array

1
1 1

100

100

100
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Example Decomposition #2Example Decomposition #2
3D Block3D Block--Cyclic Decomp on 2D Processor ArrayCyclic Decomp on 2D Processor Array

int axisType[3], axisInfo[3], glb[3], gub[3], pshape[2];

axisType[0] = stvBlock; axisInfo[0] = 10; /* Block */

axisType[1] = stvCyclic; axisInfo[1] = 3; /* Cycle */

axisType[2] = stvCollapse;

glb[0] = glb[1] = glb[2] = 1;

gub[0] = 100; gub[1] = 150; gub[2] = 200;

pshape[0] = 5; pshape[1] = 5;

decompId = stv_decompDefine( 3, axisType,

axisInfo, stvDefaultInfo, glb, gub, 2, pshape );

1
1 1

100

150

200
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Example DecompositionDecomposition #3
3D Explicit Decomp on 3D Processor Array

int axisType[3], axisInfo1[3], axisInfo2[3],… pshape[3];

axisType[0] = axisType[1] = axisType[2] = stvExplicit;

axisInfo1[0] = 11; axisInfo2[0] = 17;

axisInfo1[1] = 33; axisInfo2[1] = 57;

axisInfo1[2] = 1; axisInfo2[2] = 7;

glb[0] = glb[1] = glb[2] = 1;

gub[0] = 80; gub[1] = 90; gub[2] = 20;

pshape[0] = 3; pshape[1] = 5; pshape[2] = 2;

decompId = stv_decompDefine( 3, axisType,

axisInfo1, axisInfo2, glb, gub, 3, pshape );

1
1

180

90

20
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Additional Explicit RegionsAdditional Explicit Regions
For Extra Explicit Array Subregions Per TaskFor Extra Explicit Array Subregions Per Task

• C: int stv_decompAddExplicitPatch( int decompId,

int *lowerBounds, int *upperBounds );

• Fortran: stvfdecompaddexplicitpatch( decompId,
lowerBounds, upperBounds, info )

where:
→ decompId ~ integer handle to CUMULVS decomp
→ lowerBounds ~ lower bounds of  subregion per axis 

(global coords)
→ upperBounds ~ upper bound of subregion per axis 

(global coords)
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Example Decomposition #4Example Decomposition #4
3D Local Array3D Local Array

int decompId, glb[3], gub[3];

glb[0] = glb[1] = glb[2] = 0;

gub[0] = gub[1] = gub[2] = 100;

decompId = stv_decompDefine( 3,

stvLocalArraystvLocalArray, stvLocalArraystvLocalArray, stvLocalArraystvLocalArray,

glb, gub, 1, stvLocalArraystvLocalArray );
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Data Field DefinitionData Field Definition
• C:  int fieldIdfieldId = stv_fieldDefine( STV_VALUE varvar,

char *namename, int decompIddecompId, int *arrayOffset,

int *arrayDecl, int typetype, int *paddr, int aflag );

• Fortran:  stvffielddefine( varvar, namename, decompIddecompId,

arrayOffset, arrayDecl, typetype, paddr, aflag, fieldIdfieldId )

where:
→ fieldIdfieldId ~ integer field handle returned by CUMULVS
→ varvar ~ reference (pointer) to local data array storage
→ namename ~ logical name of data field
→ decompIddecompId ~ handle to pre-defined decomposition template
→ typetype ~ integer constant that defines data type

** stvBytestvByte, stvIntstvInt, stvFloatstvFloat, stvDoublestvDouble, stvLongstvLong, stvCplxstvCplx, stvUintstvUint, …
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Data Field Definition (cont.)Data Field Definition (cont.)
Local Data Field AllocationLocal Data Field Allocation

• C:  int fieldId = stv_fieldDefine( …,
int *arrayOffsetarrayOffset, int *arrayDeclarrayDecl, … );

• Fortran:  stvffielddefine( …, arrayOffsetarrayOffset, arrayDeclarrayDecl … )

where:
→ arrayOffsetarrayOffset ~ offset to “valid” data, along each axis 
→ arrayDeclarrayDecl ~ overall allocated array size, along each axis

Note:  Size of actual “valid” data is determined in conjunction
with data decomposition information…
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Data Field Definition (cont.)Data Field Definition (cont.)
Processor “Address”Processor “Address”

• C:  int fieldId = stv_fieldDefine( …, int *paddrpaddr, … );

• Fortran:  stvffielddefine( …, paddrpaddr, … )

where:
→ paddrpaddr ~ integer array containing the local task’s position  

in the overall processor topology (pshape)
* paddr index starts from 0!

(NOT the “physical” processor address!)

E.g. if  Pshape = { 4, 4, 2 } and  Prank = 3,
then Paddr = { 2, 3, 1 } represents:

the 3rd processor of  4 along axis 1
the 4th processor of  4 along axis 2
the 2nd processor of  2 along axis 3

“ME”
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Data Field Definition (cont.)Data Field Definition (cont.)
Access/Usage FlagAccess/Usage Flag

• C:  int fieldId = stv_fieldDefine( …, int aflagaflag );

• Fortran:  stvffielddefine( …, aflagaflag, … )

where:
→ aflagaflag ~ integer flag to indicate external access to field:

** stvVisOnlystvVisOnly ~ access data field for visualization only
** stvCpOnlystvCpOnly ~ access data field for checkpointing only
** stvVisCpstvVisCp ~ access data field for visualization and checkpointing
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Example Data Field #1Example Data Field #1
100x100x100 Float Array on Processor { 1, 2 } of  Decomp

(E.g., say, as part of 1000x1000x1000 Global Decomp)

float foo[100][100][100];

int fieldId, declare[3], paddr[2];

declare[0] = declare[1] = declare[2] = 100;

paddr[0] = 1; paddr[1] = 2;

fieldId = stv_fieldDefine( foofoo, “Foo”, decompIddecompId,

stvNoFieldOffsets, declaredeclare, stvFloat, paddrpaddr,

stvVisOnly );



ORNL Kohl/2005-59

Example Data Field #2Example Data Field #2
80x80x60 Double Array on Processor { 2, 1, 3 } of  Decomp
(With 10 Element Neighbor Boundary in Local Allocation)

double bar[100][100][80];

int fieldId, offsets[3], declare[3], paddr[3];

offsets[0] = offsets[1] = offsets[2] = 10;

declare[0] = declare[1] = 100; declare[2] = 80;

paddr[0] = 2; paddr[1] = 1; paddr[2] = 3;

fieldId = stv_fieldDefine( barbar, “Bar”, decompIddecompId,

offsetsoffsets, declaredeclare, stvDouble, paddrpaddr, stvVisCp );
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Particle DefinitionParticle Definition
A Container for Particle Data FieldsA Container for Particle Data Fields

• C:  int particleIdparticleId = stv_particleDefine( char *namename,

int dataDimdataDim, int *glbglb, int *gubgub, int ntasksntasks,

STV_GET_PARTICLE get_particle(),

STV_MAKE_PARTICLE make_particle() );

• Fortran:  stvfparticledefine( namename, dataDimdataDim, glbglb, gubgub,

ntasksntasks, get_particle, make_particle, particleIdparticleId )

where:
→ particleIdparticleId ~ integer particle handle returned by CUMULVS
→ namename ~ logical name of  particle wrapper
→ dataDimdataDim ~ dimensionality of  particle space
→ glbglb, gubgub ~ global bounds of  particle space
→ ntasksntasks ~ number of  parallel tasks cooperating on particles
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Particle Definition (cont.)Particle Definition (cont.)
UserUser--Defined Particle FunctionsDefined Particle Functions

• C:  int particleId = stv_particleDefine( …,

STV_GET_PARTICLE get_particle()get_particle(),

STV_MAKE_PARTICLE make_particle()make_particle() );

• Fortran:  stvfparticledefine( …, get_particleget_particle,

make_particlemake_particle, … )

where:
→ get_particle( )get_particle( ) ~ user-defined accessor function

* returns a user-defined handle to CUMULVS for the given particle

→ make_particle( )make_particle( ) ~ user-defined constructor function
* allow CUMULVS to create a new particle (checkpoint recovery)
(Can set make_particle( ) to NULL if not checkpointing)
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Get a Particle for CUMULVSGet a Particle for CUMULVS
Particle Accessor FunctionParticle Accessor Function

• C:  void get_particle( int indexindex, STV_REGION regionregion,
STV_PARTICLE_ID *idid, int *coordscoords );

• Fortran:  get_particle( indexindex, regionregion, idid, coordscoords )

where:
→ indexindex ~ requested particle index

* positive integer value, index set to -1 for search reset
* if  particle not found for given index, should return  id as NULL

→ regionregion ~ subregion of  particle space to search
* can use stv_particle_in_region( ) utility function…

→ idid ~ user-defined particle handle returned by search
* (void *) � anything the application wants to cast it to…

→ coordscoords ~ array of  coordinates for returned particle
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Make a Particle for CUMULVSMake a Particle for CUMULVS
Particle Constructor Function Particle Constructor Function –– Checkpoint RecoveryCheckpoint Recovery

• C:  void make_particle( int *coordscoords,

STV_PARTICLE_ID *idid );

• Fortran:  make_particle( coordscoords, idid )

where:
→ coordscoords ~ array of coordinates for requested particle creation
→ idid ~ user-defined particle handle returned for new particle

* (void *) � anything the application wants to cast it to…
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Particle Field DefinitionParticle Field Definition
Actual Data Fields Associated with a ParticleActual Data Fields Associated with a Particle

• C:  int pfieldIdpfieldId = stv_pfieldDefine( char *namename,
int particleIdparticleId, int type, int nelems,
STV_GET_PFIELD get_pfield(), STV_VALUE get_pfield_arg,

STV_SET_PFIELD set_pfield(), STV_VALUE set_pfield_arg,

int aflag );

• Fortran: stvfpfielddefine( namename, particleIdparticleId, type, nelems,
get_pfield, get_pfield_arg, set_pfield, set_pfield_arg,

aflag, pfieldIdpfieldId )

where:
→ pfieldIdpfieldId ~ returned integer particle field handle
→ namename ~ logical name of  particle data field
→ particleIdparticleId ~ handle to encapsulating particle wrapper
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Particle Field Definition (cont.)Particle Field Definition (cont.)
Actual Data Fields Associated with a ParticleActual Data Fields Associated with a Particle

• C:  stv_pfieldDefine( …, int typetype, int nelemsnelems, …,

int aflagaflag );

• Fortran:  stvfpfielddefine( …, typetype, nelemsnelems, …,

aflagaflag, … )

where:
→ typetype ~ data type for particle field (stvIntstvInt, stvFloatstvFloat, etc.)
→ nelemsnelems ~ number of  data elements

* only simple 1-D arrays (vectors) are supported as particle fields

→ aflagaflag ~ same as for stv_fieldDefine( ), access flag
** stvVisOnlystvVisOnly, stvCpOnlystvCpOnly, or stvVisCpstvVisCp.
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Particle Field Definition (cont.)Particle Field Definition (cont.)
UserUser--Defined Particle Field FunctionsDefined Particle Field Functions

• C:  stv_pfieldDefine( …,
STV_GET_PFIELD get_pfield()get_pfield(), STV_VALUE get_pfield_argget_pfield_arg,

STV_SET_PFIELD set_pfield()set_pfield(), STV_VALUE set_pfield_argset_pfield_arg … );

• Fortran:  stvfpfielddefine( …,

get_pfieldget_pfield, get_pfield_argget_pfield_arg,

set_pfieldset_pfield, set_pfield_argset_pfield_arg, … )

where:
→ get_pfield( )get_pfield( ) / get_pfield_argget_pfield_arg ~ user-defined accessor/arg

* return reference to actual data storage
* extra user-defined argument, (void *) for vectored get_pfield( ) impl

→ set_pfield( )set_pfield( ) / set_pfield_argset_pfield_arg ~ user-defined constructor/arg
* for checkpoint recovery, set the values of given particle field array
* extra user-defined argument, (void *) for vectored set_pfield( ) impl
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Get a Particle Field for CUMULVSGet a Particle Field for CUMULVS
Particle Field Accessor FunctionParticle Field Accessor Function

• C:  void get_pfield( STV_PARTICLE_ID idid,

STV_VALUE user_datauser_data, STV_VALUE *datadata );

• Fortran:  get_pfield( idid, user_datauser_data, datadata );

where:
→ idid ~ user-defined particle handle

* as returned by previous get_particle( ) call

→ user_datauser_data ~ arbitrary user-defined argument
* (void *) value for vectored implementation of get_pfield( )

→ datadata ~ reference to actual data storage

E.g. if ( user_data == “density” )

*data = ((mystruct) id)->density;
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Set a Particle Field for CUMULVSSet a Particle Field for CUMULVS
Particle Field Constructor Function Particle Field Constructor Function –– Checkpoint RecoveryCheckpoint Recovery

• C:  void set_pfield( STV_PARTICLE_ID idid,

STV_VALUE user_datauser_data, STV_VALUE datadata );

• Fortran:  set_pfield( idid, user_datauser_data, datadata );

where:
→ idid ~ user-defined particle handle

* as returned by previous get_particle( ) call

→ user_datauser_data ~ arbitrary user-defined argument
* (void *) value for vectored implementation of set_pfield( )

→ datadata ~ reference to new data values to set

E.g. if ( user_data == “density” )

((mystruct) id)->density = data;
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Steering Parameter DefinitionSteering Parameter Definition
• C:  int paramIdparamId = stv_paramDefine( char *namename,

STV_VALUE varvar, int typetype, int aflagaflag );

• Fortran:  stvfparamdefine( namename, varvar, typetype, aflagaflag,
paramIdparamId )

where:
→ paramIdparamId ~ returned integer steering parameter handle
→ namename ~ logical name of  steering parameter
→ varvar ~ reference to actual steering parameter storage
→ typetype ~ data type of steering parameter (stvIntstvInt, stvFloatstvFloat, …)
→ aflagaflag ~ external access flag, same as before

** stvVisOnlystvVisOnly, stvCpOnlystvCpOnly or stvVisCpstvVisCp
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Steering Parameter DefinitionSteering Parameter Definition
Vector ParametersVector Parameters

• C:  int paramId = stv_vparamDefine( char *namename,

STV_VALUE *varsvars, char **pnamespnames, int *typestypes, int numnum,

int aflagaflag );

• Fortran:  (no Fortran equivalent yet)

where:
→ paramIdparamId ~ returned integer steering vector handle
→ namename ~ logical name of  steering vector
→ varsvars ~ array of  references to steering element storage
→ pnamespnames ~ array of  logical names for steering elements
→ typestypes ~ array of  steering element data types

* OR with stvIndexstvIndex for “indexed” steering vector (stvIntstvInt | stvIndexstvIndex)
→ aflagaflag ~ external access flag (stvVisOnlystvVisOnly, stvCpOnlystvCpOnly, stvVisCpstvVisCp)
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Steering Parameter Updates…Steering Parameter Updates…

• C:  int changedchanged = stv_isParamChanged( int paramIdparamId );

• Fortran:  stvfisparamchanged( paramIdparamId, changedchanged )

where:
→ paramIdparamId ~ integer steering parameter handle
→ changedchanged ~ status of steering parameter

* > 0 indicates an update has occurred
* = 0 indicates no change to parameter value
* < 0 indicates an error condition (bad parameter id, etc)
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CUMULVS Coupling InterfaceCUMULVS Coupling Interface
• C: int couplerId = stv_couple_fields( int fieldIdfieldId,

char *appStrappStr, char *fieldNamefieldName,

int dstFreqdstFreq, int srcFreqsrcFreq,
int dstNoSynchdstNoSynch, int srcNoSynchsrcNoSynch, int blockblock );

• Fortran: stvfcouplefields( fieldId, appStr, fieldName,
dstFreq, srcFreq, dstNoSynch, srcNoSynch,

block, couplerId )

where:
→ fieldIdfieldId ~ locally defined data field (destination)
→ appStrappStr/fieldNamefieldName ~ location of remote data field (source)
→ dstFreqdstFreq/srcFreqsrcFreq ~ frequency of coupling at source/destination
→ dstNoSynchdstNoSynch/srcNoSynchsrcNoSynch ~ synchronization requirements
→ blockblock ~ determines blocking/non-blocking coupling attempt
→ couplerIdcouplerId ~ handle for manipulating coupler connection
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CUMULVS Coupling InterfaceCUMULVS Coupling Interface
DisconnectionDisconnection

• C: int stv_couple_finished( int couplerIdcouplerId );

• Fortran:  stvfcouplefinished( couplerIdcouplerId )

where:
� couplerIdcouplerId ~ handle for coupler to disconnect
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Passing Control to CUMULVSPassing Control to CUMULVS
• After Data Fields and Parameters Are Defined

⇒ Single Periodic Call to Pass Control to CUMULVS
⇒ Once Per Iteration?  Between Compute Phases?

C:  int params_changedparams_changed = stv_sendReadyData(

int update_field_timesupdate_field_times );

Fortran:  stvfsendreadydata( update_field_timesupdate_field_times,
params_changedparams_changed )

where:
→ params_changedparams_changed ~ return code that indicates whether 

any steering parameter values have been updated
* > 0 an update has occurred, = 0 no changes to any values

→ update_field_timesupdate_field_times ~ flag to control data field “times”
* in general, just use stvSendDefaultstvSendDefault…  ☺
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CUMULVS Checkpoint InitializationCUMULVS Checkpoint Initialization
• C:  int cp_restartcp_restart = stv_cpInit( char *aout_nameaout_name,

int notify_tagnotify_tag, int *ntasksntasks );

• Fortran:  stvfcpinit( aout_nameaout_name, notify_tagnotify_tag, ntasksntasks,

cp_restartcp_restart )

where:
→ cp_restartcp_restart ~ status value, indicates restart / failure recovery

* use to circumvent normal application startup and data initialization!!
→ aout_nameaout_name ~ name of  executable file to spawn for restart
→ notify_tagnotify_tag ~ message code for notify messages (PVM only)
→ ntasksntasks ~ number of  tasks in application

* in a restart condition, this value can be setset by CUMULVS!

Note:  stv_cpInit() must be called afterafter stv_init()!
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Alternate Checkpoint Restart CheckAlternate Checkpoint Restart Check

• C:  int cp_restartcp_restart = stv_isCpRestart();

• Fortran:  stvfiscprestart( cp_restartcp_restart )

where:
→ cp_restartcp_restart ~ status value, indicates restart/failure recovery

* use to circumvent normal application startup and data initialization!!
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CUMULVS Option Interface…CUMULVS Option Interface…
Checkpointing OptionCheckpointing Option

/* Set Recovery Option to Rollback */
stv_setopt( stvDefault, stvOptCpRecoverystvOptCpRecovery,

stvOptCpRollbackstvOptCpRollback );
or

/* Set Recovery Option to Restart */
stv_setopt( stvDefault, stvOptCpRecoverystvOptCpRecovery,

stvOptCpRestartstvOptCpRestart );

• One Option of Many, Part of  Larger Interface…
• Invoke BeforeBefore You Call stv_cpInit()!  ☺

Same in Fortran:
stvfsetopt( STVDEFAULT, STVOPTCPRECOVERYSTVOPTCPRECOVERY,

STVOPTCPRESTARTSTVOPTCPRESTART ) . . .
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Checkpoint CollectionCheckpoint Collection
• Trigger Actual Data Collection from Local Task
• Invoke When Parallel Data/State Consistent

⇒ Highly Non-Trivial in General!! (Chandy/Lamport)
⇒ Straightforward for Most Iterative/Phased Applications

→ E.g. Save Checkpoint at Beginning or End of  Main Loop

• C:  int statusstatus = stv_checkpoint();

• Fortran:  stvfcheckpoint( statusstatus )

where:
→ statusstatus < 0 indicates system failure

Control Overhead Using Checkpointing Frequency:
if ( !(i++ % 100) ) stv_checkpoint();
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Restoring Data From A CheckpointRestoring Data From A Checkpoint
• After Restart Condition Has Been Indicated…
• Can Be Invoked Incrementally to Bootstrap Data

⇒ Interlace with Data Field/Parameter Definitions…
⇒ Automatically Loads Data Directly Into User 

Memory for All Defined Data Fields and Parameters

• C:  int remainingremaining = stv_loadFromCP();

• Fortran:  stvfloadfromcp( remainingremaining )

where:
→ remainingremaining ~ number of  remaining data 

fields or parameters to define/restore
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Example InstrumentationExample Instrumentation
MultiMulti--Stage Restart from a Checkpoint…Stage Restart from a Checkpoint…

/* Check Restart Status… (Returned By stv_cpInit( )) */

/* Load Program Variables From Checkpoint Data */

if ( restart ) stv_loadFromCPstv_loadFromCP( );

/* Allocate “indices” Vector Using “delta” for Size */
ix = (int *) malloc( ( 100.0 / delta ) * sizeof(int) );

/* Define “indices” Parameter for CUMULVS */
stv_paramDefine( “indices”, ix[], stvInt, stvVisCp );

/* Load Newly-Defined Program Var ix[] from Ckpt Data */

if ( restart ) stv_loadFromCPstv_loadFromCP( );
else user_init_data( );
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Oh Yeah, One Last Routine… Oh Yeah, One Last Routine… ☺☺
Finished CheckpointingFinished Checkpointing

.  .  .

/* Tell CUMULVS to Stop Checkpoint Recovery. */
/* (So Task Can Exit Normally & R.I.P. :-) */

stv_cpFinishedstv_cpFinished( );

exit( );
}
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CUMULVS Interface SummaryCUMULVS Interface Summary

• Interact with Scientific Simulations
⇒ Dynamically Attach Multiple Visualization Front-Ends
⇒ Steer Model & Algorithm Parameters On-The-Fly
⇒ Couple Disparate Simulation Models
⇒Automatic Heterogeneous Fault Recovery & Migration

http://www.csm.ornl.gov/cs/cumulvs.html

Email: cumulvs@msr.csm.ornl.gov


